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Review of the January 2008 Membership Meeting 
by Bob Pierce 

     The 31 people that attended our membership 
meeting on January 17, 2008 were privileged to 
hear a presentation by our member Kenney Brown 
as he spoke on the subject of “Windows and 
Beyond”. While this title suggests a look into the 
future, it really meant that Kenney was going to 
present a little bit on the Windows XP and Windows 
Vista operating systems, and then add a little about 
the new Apple Leopard operating system, used on 
Macintosh machines, as well as the Linux operating 
system and some of their features and 
comparisons. He had three computers with him to 
help with his presentation, one loaded with 
Windows, one with Leopard and one with Linux. 
      The two current Windows Operating Systems 
are XP and Vista. Windows XP is a proven system 
and is well thought of for the most part and is widely 
used and has a lot of support. Of the two, XP is 
probably the more popular. It is proven, reliable and 
still widely used. There is a lot of software available, 
both from Microsoft and many third party providers. 
Microsoft still provides support for XP, but that will 
be going away in the future as Vista is now the 
flagship operating system for Windows. Some of 
the positive features of Vista is that it is a more 
secure system with a number of security features 
running at all times in the background, it has the 
well-liked Aero-Graphics (3D), and several others 
depending on which version of Vista you are using. 
However, Vista is receiving mixed reviews from its 
users. The biggest complaints center around the 
fact that there is a lot of third party that is not yet 
compatible with Vista. One of the more positive 
comments is the flexibility of the “sidebar”. The 
general opinion for now is that if you have XP and 
like it, keep it. Vista is good and will be better – wait 
for it. 

     Kenney then showed us the Macintosh 
operating system, Leopard. Mac users are faithful 
to their operating system because it is reliable, easy 
to install and use, and generally secure. It can be 
argued that the reason there has been few 
instances of virus attacks is that there is not yet a 
large number of Macs out there and the hackers 
are not paying it much attention. However, as the 
number of Mac users increase, the number of virus 
attacks is also on the increase. Some Mac 
machines are now equipped with Intel processors 
rather than the Motorola chips used in the past. 
Intel-equipped Macs are running Window 
applications. (Note from the author –remember a 
few months ago when Thomas Avallone presented 
a program on that subject.) Another new 
development for the Mac is that the user no longer 
has to use a proprietary monitor – you can use any 
monitor now. The Macintosh will be a little more 
costly than a comparably equipped PC machine. 
     The last system that Kenney reviewed for us 
was the Linux operating system. While not as 
popular with users as the Windows or Macintosh 
systems, Linux is available in several versions and 
is usually free. This is a reliable system and, just 
like Leopard, is not a popular target for hackers yet, 
but it is growing in popularity. There is also an 
office-type software package available on-line 
which is also free. It is known as “Open Office” and 
is gaining in popularity, even with PC users. It 
features a word processor, a spreadsheet and a 
presentation package similar to Power Point. There 
are a number of software packages available for 
Linux now, although some users have had trouble 
obtaining drivers that work. 
     Door prize winners were Gerald Massey, Julious 
Windham and Bob Franklin. 
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Newsletter Articles Welcomed 
Please submit articles for newsletter, in RTF 
file format, by the first day of the month to  

Phillip Sanders- phillip49@sport.rr.com 
And to Ben Fusco-benfusco@bellsouth.tnet 

Membership Dues  
Full: $15.00 a year 

Spouse: $6.00 a year 
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Visit Our Web Site 
http://www.shreve.net/~nwlapcug/ 

Words From the President 

     How 
many of you 
got new 
computers 
for 
Christmas 
that had 

Vista installed and had 
peripherals that wouldn’t 
function because no drivers 
existed for them in Vista?
    One solution for this is to 
install Xp on the computer 

with Vista. The problem with 
this every time the computer 
boots, we have to choose the 
operating system to boot to. 
There is another way and 
that is with virtual PC. It will 
allow us to have Xp running 
on a virtual desktop in Vista. 
     The Saturday SIG 
program will cover this in 
detail this month so bring a 
friend and attend. 

��������	
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Photos taken at the January 2008 Membership Meeting  
By Glenda Conradi 

Gerald Massey Bob Franklin Julious Windham 

Kenney Brown 
Guest Speaker 

Judy Wilson Director  
checks out name tags for attendees 

Kenney Brown holds a side chat session with 
President, Pat Joyner and 2 other members.   
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Corel Graphics /Photo SIG January 8, 2008  

     Since the first Tuesday of the 
month happened to fall on New 
Years day we held the Corel 
Graphics/Photo SIG on the second 
Tuesday in January. We had a 
nice turn out and covered a lot of 
things. 
      Some of the tips dealt with 
caring for your digital camera. We 
talked about cleaning the lens 

using a lens safe tissue or cloth & cleaner, and not 
spraying cleaner directly on the lens. You should avoid 
the elements and keep your camera dry and out of 
extremely high temperatures. If you are storing a camera 
for an extended period of time it is a good idea to put 
silica gel pouches in with the camera to protect it from 
moisture.  

Be sure the camera is done writing pictures to the 
memory card before you remove the card. 

It was also noted that the CompactFlash Association 
has issued a warning about the potential of the 
CompactFlash media's semiconductors' possibly being 
damaged by the sanitizing irradiation sometimes used 
by the U.S. Postal Service. 

Free photo editing software was also one of our 
topics. There are a variety of free versions of photo 
editing programs that you can download from the 
Internet. They may not include all the features that many 
of the programs you buy have, but they are free and 
may be all you need to get the results you want. Some 
of the free programs are Shutterfly, SerifSoftware, 
Picasa 2 and Gimp. Shutterfly lets you make your 
pictures look their best with easy online tools. 
SerifSoftware-PhotoPlus lets you fix and enhance digital 
photos, create bitmap graphics and do web animations. 
GIMP is an acronym for GNU Image Manipulation 
Program. It is a freely distributed program for such tasks 
as photo retouching, image composition, use of plug-ins 
and supports a variety of file formats. It is also very 
powerful, especially for a free program. Picasa is 
software that makes it easy and fun to view, organize, 
edit and share the digital photos on your PC.      

                          

One of our projects was to create Sketch or Coloring 
Pages From Photos we had taken. If you would like to 
try this in Corel Paint Shop Pro X2 

1. Open a digital image in Corel Paint Shop Pro 
X2. 

  2.   In Adjust menu choose Digital Camera Noise  
Removal. Check Link detail sizes box, and 
change the Small setting to 1.0. All three Noise 
Correction settings should change to 1.0 at the 
same time. Change the Correction blend to 70 
and make sure Sharpening is set to 0. Click OK. 

3.   Choose Adjust - Smart Photo Fix.  
Brightness overall 43 - Shadows 25 -    

Highlights 15 - Saturation 51- Focus 50 
Turn Your Photo into a Sketch 

4.    Choose Effects > Edge Effects > Find All. Your 
photo should look a little like a pencil sketch 
now. 

Make the Lines Bolder 
5. Choose Adjust > Brightness & Contrast > Levels.  

Channel: RGB 
 Levels: 17 - 145 and 248 

Once you make these changes, click OK.  
Save Your Image With a New Name and Print Page.  

                                                         

We also looked at photos taken by Bill and Cisly 
Morgan and Carole White. I printed them out and 
passed them around so everyone could get a good look 
at them. They were good examples of photo techniques 
we have talked about in the SIG meetings. 

 
 
 
 
 
 
 
 

We talked about EV (Exposure Value) and how it 
can be adjusted to help prevent under or over exposure. 

We hope you will be able to make the next Corel 
Graphics/Photo SIG on the first Tuesday of the month at 
7:00 p.m. at Podnuh’s Bar-B-Q, located at 1146 
Shreveport-Barksdale Hwy. The room in the back is 
reserved starting at 6:00 p.m. for those of us who would 
like to eat and want to do it before the meeting starts. Of 
course it is fine to eat during the meeting, too. Please let 
me know if you have questions, or suggestions, that can 
be used in our SIG meetings for part of the program. If 
there is something you would like to see covered at one 
of our meetings you can email me at glenda@conradi.
com.  

Carole White 
See Note 2 

Cisly Morgan  
See Note 1 

Note 1 - Example of adjusting focus so the eyes are sharp 
and the fence is out of focus, drawing more attention to 
the eyes 
Note 2—Picture of bridge, dock and lake shows the 
effectiveness of diagonal lines drawing the viewer’s eyes 
into the pictures’s main focal point.  

 Picture of 
Glenda’s Grandson  

Henry Conradi.  
This is an example of 

creating coloring  book 
pages.  
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Windows SIG January 2008  
by Bernie Conradi 

It was a very cold and 
windy night for the SIG this 
evening.  Podnuh’s had 
another meeting in the 
main dining room at the 
same time as our Windows 
SIG and as a result it was 
very difficult to find a park-

ing place.  Some of us had to walk a ways to 
get to the meeting.  Leo Bellotte and Pat 
McDowell were visitor this evening.  We hope 
that they return again.  Glenda made the an-
nouncement about Ed Waites passing away 
and giving us the times and location of the fu-
neral.  I announced the latest virus program dat 
files and cautioned all about some of the latest 
scam and phishing items that are circulating 
now.  One being that if you are going to donate 
to a presidential candidate over the internet, be 
sure where you are sending your money.  Be 
sure it is a legitimate site that you are visiting.  
There are many scammers out there that would 
like to take your money. We gave some tips on 
how to keep your computer running smoothly 
by eliminating unwanted or unused programs, 
keeping the antivirus programs, spyware pro-
grams, and Windows up to date with the latest 
updates. Be sure to get all the Critical Updates 
for Windows, as most are security updates. I 
recommend you set your computer to automati-

cally download the updates. It was announced 
that Netscape will discontinue any support and 
updates for their browser on February 1, 2008.  
Netscape recommends that you switch to 
Mozilla Firefox. There was a discussion about 
User Accounts in Windows XP and Vista.  User 
accounts are set up for the purpose of protect-
ing your computer systems files by restricting 
what can be installed automatically. With a user 
account you must give permission in order for 
items to be installed on your computer. We 
demonstrated how you can put the cursor on 
an active link in an email or on a web page and 
see exactly what the real link is, in the margin 
at the bottom of the page. The program gave 
us information as to why some file names listed 
in Windows Explorer are blue in color.  If you 
check the compress files feature in the Disk 
Cleanup function, you will have all files that 
have been compressed show up with a blue 
color.  You can also compress any file manu-
ally if you need to save hard drive space.   

Please join us at 7:00 PM on February 22, 
2008, at Podnuh’s Bar-B-Q on Shreveport-
Barksdale Highway. Everyone is invited to at-
tend. I am looking forward to suggestions for 
upcoming programs as I want to present sub-
jects of interest for all in the group. Let me hear 
from you.  

You can email me at bernie@conradi.com.   
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Cisly’s Whale 

Digital Photo February—2008  
by Bill & Cisly Morgan 

         Due to some 
previous obligations, 
we were unable to do a 
January SIG, However, 
we thought we would 
use this opportunity to 
write about some of the 

more useful features in the new Photo Editing 
Software. 
     As most everyone knows, We do all our Photo 
Editing with Corel Paint Shop Pro, and that is the 
software we use in our Digital Photo SIG as well.  
However, one software company really doesn’t get 
very far ahead of the others. Glenda, in her Corel 
Draw SIG, does a good job of showing the new 
features and upgrades in quite a few different 
programs. And, as everyone who attends her SIG 
knows, when a useful feature shows up in one 
program, it is usually added to the others in their 
next upgrade.   
     Finding the features in various programs can 
sometimes be a nightmare however. The 
terminology is usually different, the tools have 
different names, the features have different 
headings and are in different menus, and, 
sometimes, even the placement of the toolbars can 
be confusing. If you get used to a toolbar on the left 
side of the screen and you open a different editing 
program and the toolbar is along the top, your first 
thought might be, “Why did they make it so hard to 
find this stuff...”   
     But even with all that in mind, we will still talk 
mostly about the program with which we are most 
familiar–Paint Shop Pro–although, we feel sure any 
feature we talk about or use can be found in 
whatever software you use.   
     Now, with all that said, let’s look at some of the 
features that have been added or enhanced in the 
new Corel Paint Shop Pro Photo X2, or as we like 
to call it ”Paint Shop Pro 12.”  
     Auto-Preserve Originals  is a new feature that 
we were very reluctant to use at first.  We told 
ourselves, “We don’t need that.” But we tried it 
anyway. The more we got used to it, the more we 
liked the idea. With the Auto-Preserve active, when 

a change is made to a picture and it is saved, a 
copy of the original is saved in a sub-folder. As it 
turns out, in our opinion, this can come in handy. If 
you no longer need it, the sub-folder can be deleted 
when you are finished.  
    Improved Resize  command has been 
simplified. There seems to have always been 
problems with resizing. The questions: what size? 
what resolution? what ratio? should it be re-
sampled or resized? always seem to come up. And 
terminology is also a problem here. Re-sampling in 
some programs mean the same thing as resizing in 
other programs. In Paint Shop Pro12, and we are 
sure in other programs as well, the Improved 
Resize command has been simplified so it is now 
straight-forward. A simple menu pops up and you 
simply type in the size you want and in one step, 
you have it. 
    Save for Office and Copy Special  commands 
are new and simple to use. With the new, high-
resolution digital cameras, the file size can be very 
large–much larger than they need to be. The Save 
for Office makes resizing to what you need or want 
very simple. The commands work like the “Save as” 
command. You have three choices: save for E-mail, 
Save for desktop printing, and save for professional 
printing. For E-mail, your picture is saved at 96 
pixels per inch.  For desktop printing, your picture is 
saved at 200 pixels per inch. For professional 
printing, your picture is saved at 300 pixels per 
inch. No guesswork.  
    We hope to be able to show some more new 
features in future SIGs. The Digital Photo SIG is 
normally held the first Thursday of the month: 
however, the location moves around somewhat, so 
it is necessary to check your e-mail to find out 
where it will be held on any given month. 
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Use a midi file you already have saved to your computer or go to a free music site like 

http://www.midistudio.com/midi/DC_AG.htm (http://ti nyurl.com/3d96ft)  
http://www.geocities.com/~goldenoldies/jukebox5060F ont3.htm (http://tinyurl.com/ytrozb) 

to find a song you like or that is appropriate to the subject of your email. 
Right click on the name of the song; left click on “Save Target As” and save the music to 
your computer. Windows already has a music folder prepared for you in “My Documents” 
     

Now, to create an email containing music that starts playing immediately upon being opened.   
(1) Start a new message in Outlook Express or Windows Mail.  

(2)  Click on Format>Background>Music  and browse to the song you want to include in your outgoing 
letter. (This is also where you will find options for choosing a background image or solid color for 
your outgoing email.)  

(3) You will be given the option of how many times you want it to play before it stops, click ok. You will 
then hear the song you have selected. Address your email and send as usual. I always note in the 
email I send to “turn on sound” as everyone does not always have their speakers on. You may also 
use a .WAV file but it makes your email message file much larger and takes longer to download. I 
NEVER send an email message with music in it to my friends who have Dial up. It takes way too 
long to download and they just give up. 

Next month I will cover the correct way to forward email. 

��������
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Putting Music in Your Email in Outlook Express and Windows Mail 
by Carolyn Franklin 

 
Preview of the February 21, 2008 Membership Meeting  

by Robert Saucier 
We are in for a real treat for our meeting on the 21st. Better come early for a seat for this one...cause, at 

our podium we have again Melanie Cathey our favorite "teacher" from Byrd High School. She also will bring 
with her student support . 

Melanie says, these young people have something to say and she's going to let them just say it.  
These young people will explain how they use "iPods and other MP3 players" and most of all, why they 

enjoy SO MUCH being "plugged into one of those all the time"....and why they really use and can't live 
without one.  

You gotta hear this one and who better to tell it than the iPod generation.  
Remember it's Thursday the 21st. of February...with refreshments beginning at 6:00 p.m. and "the 

Show" at 7:00 p.m....come prepared to get all this onto your computer. Let's welcome Melanie Cathey and 
her best students.  
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Our SIG leaders are in the heart of 
NWLAPCUG’s monthly activities. See the chart on 
the last page of this newsletter  for  the  monthly 
schedule of their meetings. Every member is 
welcome to attend any or all of their meetings and 
for as many times as they wish. All of this with  
no extra fees involved.  

 SIG leaders are dedicated to sharing their 
expertise in their particular programs. Their 
meetings include presentations, demonstrations and 

cover questions and answers. In some cases, 
handouts may be furnished. 

Following the SIG meeting, a number of the 
SIG leaders will submit an article, reporting on  the 
activities of their meeting, for publication in the 
next month’s newsletter.  

Members are encouraged to take a tour of these 
SIGs and determine which one or more appeals to 
their liking. 

 

NWLAPCUG’s Special I nterest Group  Leaders 

    

J.C. Barnett 
Word SIG 

Joe Cislaghi 
Getting Started SIG 

Bernie Conradi 
Windows SIG 

Glenda Conradi 
Corel Graphics/Photo 

SIG 

    

Pat Joyner 
Saturday SIG 

Bill & Cisly Morgan 
Digital Photography SIG 

  

Members furnishing newsletter articles 

     

Bob Franklin Carolyn Franklin Phil Sanders Bob Pierce Ben Fusco 

Computer related newsletter articles are welcomed 
from our members who are other than SIG leaders. 
We appreciate as few as one article a year. Or as 
many (not to exceed one per month) as you would 
like to generate. The range of topics is virtually 

unlimited. To name a few, your experience/opinion 
with certain software programs, the entertainment 
and educational value in computer use, How To’s, 
Tips, etc. etc. Your participation may surface one 
of your great hidden talents.   



MONTHLY CLUB ACTIVITIES  
                    PLEASE NOTE THAT SIG TIMES, DAT ES AND LOCATIONS ARE SUBJECT  TO CHANGE.  

FOR THE LATEST INFORMATION CONTACT , VIA E-MAIL,THE  RESPECTIVE SIG LEADER AS LISTED BELOW .
                                                                                                                                                                                                                  

IF YOU NEED INFORMATION ABOUT THE SIG’S SUBJECT, MEETIING PLACE OR TIME, 
 PLEASE CONTACT THE PERSONS LISTED ABOVE 

Meeting Places 
Podnuh’s Bar-B-Q -  1146 Shreveport-Barksdale Hwy (CorelDRAW/Graphics SIG; Windows SIG) 
LSUS Science Lecture Auditorium - South side of Campus (General Meeting) 
Room 123, Science Building-Southside of campus (Digital Photography SIG) 
Broadmoor Library– 1212 Captain Shreve Drive - (MS Word SIG; Saturday SIG 
Hamilton/S. Caddo Branch Library, 2111 Bert Kouns (Board Meetings; Getting Started SIG) 
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Corel Graphics/Photo SIG First Tuesday                7:00 P.M. 
 Podnuh’s Bar-B-Q 

Glenda Conradi glenda@conradi.com 

Digital Photography SIG First Thursday               7:00 P.M. 
 Room 123, Science Bldg., LSU-S 

Bill and Cisly 
Morgan 

cisly@shreve.net 
 

MS Word SIG Second Thursday                                         
2:00 P.M. Broadmoor Library 

J C Barnett jcbarnett875@cjox.net 
 

Getting Started Third Monday 
9:30 AM—Hamilton/S. Caddo Library 

Joe Cislaghi cislaghij@bellsouth.net 

Board of Directors Meeting Mon. in the week of the General Mtg. 
2:00 P.M. Hamilton/S. Caddo Library 

Pat Joyner patbj@bellsouth.net 

General Meeting Third Thursday              7:00 P.M. 
LSU-S Science Lecture Auditorium 

Pat Joyner patbj@bellsouth.net 

Windows SIG Fourth Thursday              7:00 P.M. 
 Podnuh’s Bar-B-Q 

Bernie Conradi bernie@conradi.com 

Saturday SIG Fourth Saturday               2:00 P.M. 
Broadmoor Library 

Pat Joyner patbj@bellsouth.net 

Meet Our NWLAPCUG Officers 

    

Pat Joyner 
President & Director 

Dr. John Hardin 
Vice Pres. & Director 

Jack Barnett 
Secretary & Director 

Robert Saucier 
Treasurer & Director 

 

  

 Bob Pierce 
Director 

 
 
 
 
 
 Joe Cislaghi 

Director 
Bob Franklin 

Director 
Judy Wilson 

Director 


